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"A Search for Knowledge" This is part of a wall - all in colour - from 
an inner city youth club. The whole was turned into Grayscale with 
the exception of the eye, and the word KNOWLEDGE which was 
originally painted just once, was cloned a number of times to assist 
with my title. A Pentium 200 with Photoshop 4 was used, with the 
original transparency from Kodak Photo CD. 

"Spanish Graffiti" Two images from slides input to a 
Pentium 200 with Kodak Photo CO. The original 
transparency was from Mojacar in Spain, the graffiti came 
from the wall of an inner city youth club, inserted with a 
layer on Photoshop 4. 

''.Jazz-Man" A street performer in Bath 
against an uninteresting grey stone 
wall. The Jazzman was selected and 
the remainder of the image had small 
blobs of colour dropped on the wall -
Noise and Motion Blur filters used. 
Photoshop 4, original image from a 
transparency on Kodak Phot0 CD. 
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"Awen" Scanned from a 6" x 4" 
snap taken at a redundant flour 
mill in Portmadog. Very little 
manipulation apart from the use 
of the Unsharp mask filter and 
soft edges added for presenta
tion. 

John Long ARPS APAGB 



Look "No Computer" 

My initial encounter with phocography led I was queuing for a colour photo copy one 
me to believe that it was coo complicated, "f' day (Monash University, Melbourne), when I 
numbers were an apt description I thought overhead a student (graphics) ask for a 
then. Originally handed a twin lens reflex at positive/negative of his art work. A shutter 
an school, I promptly 
went out and over 
exposed the film although 
the results held an interest 
for me. later, owning a 
Yashica Mat, I recall dawn 
train journeys from the 
suburbs into the London 
markets -The Borrough 
(Fruit & Veg.), Bi lingsgate, 
Smithfield. The Derby, of 
course, was another event 
for character studies. 

I felt limited by the 
format of 12 exposures 
on 120 B&\V film, each 
frame became too 
precious. Around this 
time the camera was 
"half-inched" when 
travelling by bicycle 
through France. I felt 
that I had had my use 
from it and that it had 
become merely a 
possession. The next 
camera, sometime later, 
was a pinhole (cocoa tin) 
and the next a Praktica 
from a local second hand 
shop. They all recorded 
what I saw. They served 
me. They all had their 
place in their time. 

I have now owned a Nikkormat since 1985. 
My equipment has not changed apart from 
the addition of a skylight filter and a no. 3 
close up lens. What has changed is how I 
see things. No longer being satisfied with 
recording what my eye can see faithfully as 
possible, I now want co create from what my 
eye sees and what my imagination sees too. 

in my brain creaked and an infmitesimal ray 
of light pierced through. 
The machine used at the university was a 
Canon 600. At the time I was working on a 
series of small collages, some of which I later 
enlarged and altered using the positive/ 
negative effect. Turning a corridor in the 
windowless tower block which passed for an 
art school, a noticed a fly leaf announcing 
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two half day work shops on the "artistic 
uses" of laser printers. That was for me! 

One thing that I had noticed was that this 
enlightened state was proving very 
interesting, if not exciting, but that it was 
costing me a small fortune. 

I was now beginning a portfolio of prints. 
There was no doubt about it, Canon were 
ahead of their rivals. They delivered prints 
with a photographic clarity. During a 

temporary fit of self
assurance, I contacted 
Canon Copiers Inc, 
Melbourne and eventually 
spoke with the right person. 
It cook some time, and 
several cancelled appoint
ments but a time was made 
to meet. This resulted in 
me being given a sponsor
ship entitling me to 200 A3 
full colour copies on their 
CLC 700 and CLC 800 
machines plus 5 BJ Al 
copies. Yes, I was lucky 
with the right person on 
the right day! 

I was fortunate enough to 
gain access to training 
facilities and was given 
time to play with the 
equipment. I had an Al BJ 
print selected for the Shell, 
Freemantle Print Award. 
From the material that I 
had amassed I found I 
could swap and change 
things around. Nothing 
was precious. I cook 
scissors and cut images out 
and then reassembled 
them. Bringing different 
images together created 
new images which you 

could not find anywhere else but that was 
not important. \Xlhat was important was 
the strength of impact of these new images. 
Does it work or doesn't it? Does it say 
something? 

Malcolm Deering 
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Historical 
Re-enactments 

Another scene from the same trench 
system with the trees and foliage 
removed from the background. The 
manipulation included dodging and 
burning, plus filling out highlights 
with noise and gausian blur. 

Paul Isemonger 

A photograph of a re-enactor 
from the "English Civil War 
society". By altering the 
levels, increasing the 
contrast of the eyes and 

dodging and burning I was 
able to match the print 
with the image in my mind. 
This picture has been 
published several times 
now. 

A black and white 
photograph of the 
re-enactment group 
"The Great War 
Society" at their 
trench system in 
Essex. The levels 
were adjusted along 
with the brightness 
and contrast in 
particular areas. 
Dodging and 
burning improved 
the effect. 

The original picture of Le Haye Saint was a lantern 
slide ( circa. 1890 ) of a scene from the battle of 
Waterloo. I photographed each figure separately 
and inserted them via layers into Photoshop. The 
building was changed to look the correct period of 
1815. 

A manipulated image 
from two colour 
transparencies of the 
"Britannia" re
enactment society. It 
was necessary to 
move the eyes apart 
using a flopped copy 
of the right eye as the 
original left eye was 
partly obscured by 
the nasal bar of the 
helmet and gave a 
rather crossed eye 
look. The colour 
balance was also 
adjusted. 



Glenys Taylor ARPS 

Jack Casement ARPS 
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I like simple pictures, the picture of the orchids and moth has no 
hidden depths and requires no work from the viewer to understand it. 
Having said that, the picture should saris~, the mind and the eye, if only 
for a second or two. After all life is short. 

This picture is made up of six layers, I like to keep the layers separate as 
I often go back to a picture and change one layer. There is only one 
blossom, it has been duplicated, darkened made slightly smaller and 
rotated to look right (lam a great believer in if it looks right it is right). 
The insect was added to give balance. The most important element to 
any digital picture is the shadow, there are so many digital pictures that 
look as if the selections have been stuck on, like in old fashioned scrap 
books. This picture has been given the appearance of light just glancing 
across the flowers, touching the insect and giving soft shadows. 

An easy way of giving a shadow is to duplicate the layer of the object you wish to give a 
shadow to. Use the lower layer of the object, click on preserve transparency, fill with black, 
click off preserve transparency, move the shadow to the position you want, use gaussian 
blur so the edges of the black shadow become soft, then lower the opacity of that layer. 

This photograph is of one of the prettiest fishing villages in the Costa 
Brava, Calella de Plafrugell. Unfortunately, one cannot escape the 
construction crane on the horizon. To improve this aspect of the 
photograph the author has applied a minimum amount of digital 
manipulation. Initially the image has been adjusted using auto-levels and 
adjustmenrs to march the printer to the image on the screen. The crane 
was then removed using the rubber stamp tool ( a favourite of mine) 
using the surrounding sky ro substitute for the crane., and finally the 
image was cropped to remove some of the messy foreground and an 
excess of sky. The result is a more acceptable record of an idyllic shot. 

Cliff Davies LRPS 

Please ensure that you hold the full 
copyright of any material submitted for 

exhibition or for publication. Any person 
submitting pictures or text will be assumed 
by the Royal Photographic Society and the 
Digital Imaging Group to accept complete 
responsibility for any legal infringements. 
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Graphics Flies 
programs wi ll check the context of the data 
and refuse to open the wrong file type but 
this requires the file type to be recorded 
with the data. This may involve saving your 

.._ _____________ file with the correct name eg. piccy.]PG 

Do you know the difference between 
information and data? The two are often 
confused but perhaps the following example 
will make the difference clear. 

Here is some fascinating data: 

The data does not become information until 
you are provided with the structure and the 
context. The straight list of numbers means 
nothing to anyone. (OK so far?) Now to · 
convert the data to information I will need 
to tell you that the data structure uses 
groups of six digits. The first two digits 
represent the day, the second two the 
month and the last two the year. The 
context is dates of birth. ie. 3rd December 
1965, 30th April 1978 etc. Of course by 
using just two digits for the year we have 
created the infamous "millennium problem". 
Just two digits does not enable is to include 
information about the century and this is 
not just a millennium problem. In fact by 
compressing the data from four digit dates 
to two digit dates we have lost some 
information. I have encountered the 
difficulties when trying to use a spreadsheet 
to contain data from a survey of gravestones 
in a church yard. The standard two digit 
date format does not permit any other than 
20th century dates. Therefore this data 
structure has resulted in the loss of some 
information ie. 87 = 1687 or 1987 or 2087? 
(Note: on the Mac you can enter the full four 
digit date format and then all is well again. 
In fact it will automatically calculate the 
name of day of the week and check that the 
date is possible eg. 30th February will be 
rejected.) 

(What is the relevance of this to graphics?) 
All data on the computer is held as a long list 
of digits. To interpret the data a text, 
numbers, sound, graphics etc. etc. the 
structure and context need to be known. 
There is nothing stopping you opening your 
picture as a text document but the resulting 
text will be incomprehensible rubbish. At 
worst you will translate some data as 
computer control commands which will 
corrupt or crash you computer. Most 
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(The Mac files contain a 'header' which 
stores information about the program which 
created the file and its type.) Having said 
this there are some very intelligent pro
grams which are designed to open any file 
type and to provide useful information. 
(Dataviz on the Mac has translators for many 
file types and enables you to open files for 
which you do not have the original program 
whether that was on a Mac or a PC 
compatible.) 

Graphic files are stored a using a number of 
different structures. These include PICT, 
TIFF and JPEG. The choice of structure 
determines which other programs will be 
able to interpret your file, how large the file 
will be and how much information is lost 
from the original graphic. 

If you intend to use your graphic in a Desk 
Top Publishing program such as PageMaker 
or Quark Express it is necessary to ensure 
that your file is recognised by that program 
and that it gives the desired quality of 
output. It will also be necessary to match to 
the final method of printing ( check with 
your print bureau). Photoshop and other 
programs enable you to convert from one 
file format to another. 
The size of a graphics file is determined by 
the following factors: Picture size ( eg. 20 x 
15 cm), Image mode (eg. RGB colour, CMYK 
colour, grayscale or black & white), pixel 
depth (eg. 8, 16 or 24 bits) and the resolu
tion (eg 200 dots per inch). 

A popular file format for graphics where it is 
necessary to reduce the file size is JPEG. 
Ooint Photographers Expert Group) The 
data is compressed by eliminating some 
information and modifying the data 
structure used. It is possible to choose from 
a range of compression values but the 
greater the compression the more informa
tion is lost. The trick is to know how much 
information you can afford to lose before 
your chosen method of output is adversely 
affected. Pictures destined for publication 
via Internet will be displayed on computer 
screens where the quality required is quite 
low whereas a picture for publication in a 
printed journal will require a higher quality. 
(Note that repeatedly saving a file in a 
compressed format will involve a cumulative 

loss of information so work with the 
uncompressed format and only compress 
when finished.) 
A full understanding of compression 
techniques involves some very advanced 
maths (Fourier transforms ! ? !) and physics. 
However, you may be interested in a very 
much simplified explanation. 

A file may contain information which repeats 
data. For example instead of writing a list of 
birthdays which are exactly the same you 
may write that the next fifty dates are each 
120385. The data structure will need to be 
amended and the interpreting program 
must be able to interpret it (eg. 
509999120385). This is much shorter than 
listing all the fifty dates and relies upon the 
fact that the code 9999 could never occur in 
any date. Areas of the same colour may be 
similarly encoded rather than listing the 
colour of each and every matching pixel. In 
these instances no information need be lost. 

Now for the more difficult part -stay with it! 
Colour monitors display images using the 
three primary colours for projected light 
which are Red, Green and Blue (RGB). 
Combined with equal intensity the light 
produced from these three colours is pure 
white. Val)ring the intensities of each 
produces a range of other colours. The 
JPEG compaction scheme requires that the 
data is transformed from RGB to a different 
video based encoding scheme. In this 
scheme 
there are 
two pans; 
the gray 
scale image 
Quminance) 
and the 
colour 
information 
(chrominance) 
and each 
part is 
compacted 
separately. This enables the colour 
information to be treated separately from 

the gray scale. The 
latter is in fact far 
more important to 
the human brain 
when interpreting 
the final picture 
because the eye uses 
the gray scale edges 
to indicate the 

boundaries within the picture. Therefore 



Note the importance of the 
boundary lines when interpreting 
an image. This is an approximate 
model for the luminance and 
chrominance information in a 
JPEG file. 

the colour data may be reduced to half that 
for the grayscale brightness values without 
unacceptable loss of image information. 

Let us look at just the grayscale data. lf a 
line is drawn across a section of the gray 
scale image along that line there will be a 
range of intensities of light from pure black 
to pure white. If each colour intensity is 
given a number from zero for black and 255 
for pure white then this range of intensities 
may be represented by a list of numbers 
Oust like the list of birth dates). 

These numbers may be plotted on a graph. 
Now lets just consider the extreme case 
where there are bars of black and white 
with no other intensity present. The graph 
will be a square wave graph (zeros & 255s). 

Intensity 

255 

0 '--...... .._ __ ----1, .... ~ 
pace 

~ 

(Yes, the Brunel Bridge in Bristol was 
designed by Fred Bridge!) To compress 
the data you throw away some of the high 
frequency waves. The effect of this is that 
when you conven the remaining collection 
of sine waves back to a single wave it is now 
no longer a sharp cornered square wave. In 
addition to the numbers zero and 255 for 
black and white there will now be some 
other numbers between the zeros and 255s. 
Visually this means that the sharp edge 
becomes fuzzy and this is the penalty paid 
for compressing the data (lossy compres
sion). 

Compressions in excess of 100: 1 are 
possible but with 10:1 being more normal. 
The information loss is in some detail and 
sharpness but this may be difficult to detect 
by eye. 

The nature of the picture is imponant in 
judging the comparative quality of com
pressed and restored images. The human 
brain responds differently to the pans of an 
image depending upon contrast, brightness 
and even context. Human faces are analysed 
very critically whereas changes in an area of 
vegetation may not have much significance. 

Low frequency sine wave 

Now the interesting fact (well I find it 
interesting) is that any shape of wave, 
including the square wave, may be 
constructed by combining lots and lots of 
different frequency sine waves. These High frequency sine wave 
waves will range from low to high frequen-
cies. Transforming from the square wave to (Note the "stepped" curves indicating that 
a collection of sine waves is called a Fourier the waves were copied from a low resolution 
transform and is named after the mathema- computer monicor. The pixels are showing 
tician Fred Transform. and some information has been lost.) 
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File compression is a very imponant issue 
for the production of web pages because of 
the time needed to do\vnload images over 
the Internet. MPEG files (Moving Pictures 
Expert Group) are used to make the 
transmission of videos possible. The Apple 
Quicktime system is widely used by CD 
ROM and web designers with other systems 
being developed. The combination of new 
faster and efficient compression techniques 
with faster processors and large amounts of 
. memory is making possible full screen 
realtime video technologies. 

Pictures submitted for publication in the 
DIGIT may be submitted in JPEG format as 
computer files on disk or attached co 
emails. Colour or monochrome pictures of 
normal enprint size (6 x 4 in) with a 
resolution of 200 dpi are acceptable. 
Images placed on the web site will be 
reduced to 75 dpi JPEG files or saved as low 
resolution GIFF fi les. ......................... 
To summarise the effects of compression: 

Graphics files are stored as a long list of 
numbers. The manner of storing these 
numbers may be improved to reduce the 
length of the list without any loss of quality. 
It is also possible to omit some of the 
numbers but this loses information and 
reduces the image quality. 

The original scanned image. 

The above image was saved as a lowest 
quality, compressed JPEG file with a 

resultant decrease in detail 

Bill Henley LRPS 
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Comment 

I don't think I've mentioned before, but I 
am part of a small "Internet Digital Imaging 
Group", ( IDIG ), (though so far the only 
RPS member !?) ,there are just four of us at 
the moment myself, two Londoners and 
one young lady in the USA we are, what I 
think you might call 'prolific 'workers, 
producing at least ONE new image each 
every day of the week --EACH !! -- and 
these get sent out, each day, to each of the 
other members in the group, along with 
comments/ remarks/ and general chitter
chatter in accordance with the contents 
(and images) of the previous days 
communications. 

The stimulation and excitement that 
comes from such a group is incredible, and 
bears little comparison to what we all 
know best, the more conventional 
'Camera-Club' weekly meet as for a start 
off, this is all done on a daily basis !? We 
share experiments show 'part-finished' 
work discuss/ suggest/ and comment on 
each others work ('suggested 'improve
ments are often 'carried out' on the image 
in question, by the person making the 
comments, and then sent back around the 
group for further comment)-(much like as 
if a 'club-judge' were able to bring his 
comments' to life' at a club meeting !') -
this has brought about a whole new 
dimension to 'photography' as we know it. 
The level of friendship / trust and good 
humour that abounds within the group is 
like a breath of fresh air long gone are the 
petty niggles and quibbles of society 
meetings and the willingness to share 
ideas, take on-board the views of others, 
and PRODUCE new images, is very 
rewarding. Much more akin to what I 
remember 'photographic-societies' USED 
to be like, many years ago, but now on a 
daily basis rather than a weekly one. 
We intend to allow our group to grow, (a 
little) and we will be inviting new member
ship from all over the world -- the only 
requirements for membership being:- that 
the person should be prepared to be 
'prolific', and produce, more or less, one 
new image every day -- this does not 
require the image to be an 'end-result' or 
of 'exhibition' standard, far from it, most of 
our images could be regarded as 'general
communication' and can take the form of a 
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'part-finished' work, the 'seed' of an idea, 
the result ofan 'experiment', even 'snap
shots' of potential interest to other 
members of the group. The only other 
requirement being that the worker should 
be 'creative' , 'imaginative' and 'positive' 
about imaging in general. This 'invitation' 
to join our group is extended (with great 
gusto!!) to all RPS members (of course!?), 
and in particular, to the members of the 
various area groups of the DIG. We will 
not however, be allowing the group to 
grow TOO large, as this will put too greater 
burden on the commitment to 'respond' 
on a daily basis to everything that comes in 
'from the others' --so we envisage only two 
or three new members for the time being -
- to see how that works out -- however, if 
we get a larger response than we antici
pate, then we'll just have to play-it-by-ear!? 

I am more than surprised to notice how 
seldom, if ever, one of the most significant 
benefits of 'digital-imaging' is emphasized 
in the magazines (yours included) and 
that (for me) is the unparalleled opportu
nity to both view and evaluate an image, 
under 'construction', during each of it's 
'stages-of-development' -- whether it be an 
'elaborate-manipulation' or just a simple 
'photo-retouching' exercise --without ever 
actually having to commit it to paper !' As 
you are constantly being given a 'visual' 
update as to the progress being made you 
can therefore decide at which stage the 
image is 'complete' and whether or not to 
continue down a particular route of 
manipulation, depending on the level of 
success (or lack of it) being achieved. 
There really is no darkroom equivalent to 
this phenomena, not in real terms, as, it's 
not until you make 'the print' that you 
know, with darkroom work, whether or 
not you've managed to achieve the 'end
result' you've been seeking and even then, 
sometimes, a successful outcome is only 
achieved by virtue of a little luck along the 
way. Furthermore and in my case this is 
MORE than true I find that there is no 
'need' to produce 'a print' at all, ( within 
digital-imaging) -- 99% of all my creative
imaging 'enjoyment' comes from the on
screen development of an image and 
seeing the 'end-result' up on the screen in 
front of me these images can then be 
shared with others over the Internet 
entered into competition all over the 
world and even sent for magazine 
publication without ever having to go 

'into-print' I would think that as little as 
1% of the images I create EVER get 
'printed-out' and even then, for the most 
part, it's more often than not, to provide 
for a 'photographic-society' competition, 
rather than just for personal pleasure alone 
--- all the pleasures and enjoyment of 
'phocography' can be gained, and much 
MUCH more, without having co lay-out on 
expensive papers and chemicals (paper 
and ink!?) by adopting the 'digital' route -
even less expense is incurred by going 
'100% digital' !! Why is it then, that the 
'wets' (wet-photographers) shy away from 
such intense enjoyment ?? Surely the 
object of the exercise is the enjoyment of 
your chosen hobby, be it 'photography' or 
whatever and NOT simply the 'preserva
tion' of established techniques for time 
immemorial leave that to those, whose 
hobby it is, specifically, to 'preserve 
established techniques for time immemo
rial' (')-(and there's seldom a shortage of 
THEM !?) but now photography has 
entered the 'Digital-Age' -- the level of 
enjoyment has been increased one
hundred fold the opportunity to produce, 
exhibit, SEE and share photography has 
increased by an equal amount -· so why all 
the resistance '? Are we 'condemned' by 
tradition co suffer the 'limitations' of 
darkroom-technology or are we free, as 
individuals, co seek-out new and more 
pleasurable methods of producing images 
digital or otherwise!?!? 

Barry Colquhoun ARPS 

bjc.albaco@cybersape.net 

First Faltering 
Steps In 

PhotoShop 
Those first tentative steps were taken early 
in 1997 when Photoshop 3 was installed 
onto my (then) 486 computer. The 
computer had been used extensively over 
the years for word processing as l am 
active both in the Western Counties 
Photographic Fedemion and as Secretary 
of my own photographic society. Whilst l 
have been a serious monochrome print 
worker for many years, l have never made 
a colour print in my life and the idea of 



Roy Rainford ARPS 

producing colour images was ve1y 
appealing. I bought a Hewlett Packard 
609C colour printer, read one of the many 
instruction books available and practised 
with some royalty-free images from one of 
the C.Ds which can be found on computer 
magazines. 

Barrie Thomas led a workshop in Taunton 
which I attended and this encouraged me 
to get a mixture of colour slides and colour 
negatives put onto a Kodak Phoco CD -
and I was away! At about this time I made 
a very rash statement at my club 
(Kingswood P.S) -Yes, it is interesting, but 
I'm not taking it seriously - that remark has 
since come to haunt me! 

March of 1997 saw my first 3-layer image 
entered into our Quarterly Competition at 
the club and co my amazement - and 
delight - the judge placed it first and 
afterwards said he was unaware it was a 
digital image. I am sure most of you can 
imagine the outcome - me, a serious 
monochrome worker -a digital image -a 
colour print - placed FIRST!! Encouraged 
by this early success, I delved deeper into 
Phmoshop by buying a book recom
mended by Glenys Taylor 'FUNDAMEN
TAL PHOTOSHOP' which resulted in many 
restless nights with bezier curves, unsharp 
masks, defringing, channels and quick 
masks going around in my head. 

Being retired and living along, I neglected 
the decorating, the car cleaning, the 
hoovering and dusting etc and spent even 
more hours battling with the complexities 
of the computer and Photoshop, but 
learning some important things in the 
process. About this time Derek Dorsett 
FRPS visited my society and stayed 

Taken early 
morning on the 
Mont Blanc range. It 
wasa colour 
transparency 
scanned onto Kodak 
Photo CD. Changed 
to grayscale in 
Photoshop 4.0 & 
enhanced using 
'levels', 'rubber 

stamp'& dodge/burn cools. Clouds were 
imported from another early morning shot 
& positioned using layers. 

overnight with me. I showed him my 
limited collection of images and received 
some encouragement from his remarks, 
but strongly suggested that I should be 
using Phocoshop 4. I decided to crack 
open the piggy-bank and upgraded to 
Pentium 90, a l 7in monitor, 64 Mg of RAM 
a flat-bed A4 scanner and Phocoshop 4 -
then had to learn some of the processes all 
over again after the upgrade. I wanted to 
see what others were doing, so as I was 
already a member of a UPP monochrome 
circle, I joined the newly formed UPP DJ.2 
circle which consists of 20+ members of 
mixed ability, so we are able to help each 
other with advice and tips. Glenys 
encouraged me to join the DI Group (I am 
already a member of the Creative Group 
where we see lots of digital images), I 
attended several more workshops and 
regional DI meetings -and gradually 
progressed wi th a selection of reasonable 
prints which saw the light of day in 
competitions and exhibitions; I was even 
invited co talk co the South Wales DI 
Group! Modest success in the form of six 
01 images in one exhibition, including a 
PAGB Ribbon has encouraged me to 

upgrade once again to Pentium 200 with 
128 Mg of Ram, a 4Mg Graphics Card and 
trading in the HP printer for an Epson 600. 

So here we are in April 1998, just over a 
year since I was bitten by the bug, and 
even been talked into being elected to the 
committee of this group. Does this mean I 
have arrived -or am I just another 
struggling pixelographer? 

John A Long ARPS APAGB 
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Split Toning 

Recently, an article was published in the 
popular photographic press about 
obtaining split toned images using 
PhotoShop. This works by first 
desaturating the image to remove all 
colour ( do NOT convert to grey scale or 
you will have co convert back to RGB!). 
Adjust, curves; select the blue channel and 
by bending the cop half of the line 
downwards, a yellowing of the highlights is 
seen; raising the bottom half of the line 
gives blue shadows. Accept if liked. Save 
etc. 

This works well enough and if recorded as 
an "action" can be repeated easily. 

In Picture Publisher, it is just as easy and 
the following method adds both red and 
yellow (giving a kind of sepia) to the 
highlights, and a subtle coldness to the 
shadows:-

Hue Shift, Saturation shift -100 
(desaturates). OK. 
Map, Colour Balance Ooystick) , Channel 
Blue, Tonal range Highlights Balance -10 
(=10 yellow). OK. 
Map, Colour Balance Ooystick) , Channel 
Red, + 7 OK. 
Map, Colour Balance Ooystick) , Channel 
Master " Shadows " -3 (to darken). 
OK 
Map, Colour Balance Ooystick) , Channel 
Bl~ +lO OK. 

By invoking Edit, Command List, Edit, and 
Save, a macro can be created and saved for 
easy repeating. If later, using notebook, 
the ".elm" macro file to be found in e: 
\Piccure Publisher\ Macros is loaded, the 
macro can be edited manually if desired. 

A similar method is also possible in Photo 
Shop using Image, Adjust, Colour Balance 
etc. 

Now do a test print to make sure that the 
print colours are exactly the same as you 
saw on the screen .... I bet they are not! 

John Wigmore FRPS AFIAP 
DPAGB APAGB 
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Digital-Portfolio 

Boac 

This is from a slide taken some 14 years 
ago in Tenerife. I recently purchased a 
book entitled "The Photo Shop 4 WOW 
Book" which includes a CD ROM with a 
very interesting set of preprogrammed 
"Actions" which are available in Phot0shop 
Version 4. There are dozens of different 
Action which you just click on the play 
button to start a sequence of operations 
including various filters and other 
operation. The one used on the Boat 
image is called Wow Painting/Canvas/Lite 
which includes the following operations / 
filters: Levels, Hue & Saturation, Dry Brush 
filter, Create new layer, Emboss Filter, 
Gaussian Blur Filter, Create new layer, 
Texturizer/Canvas Filter, and Layer 
options. Following all that which took only 
a few minutes I then flattened the layers 
and did a layer copy before applying a 
Gausian Blur to the background image the 
reduced the opacity on the t0p/copy layer 
to let the unblurred image show through 
WOW!! The result as shown printed up 
quite well. 
PS I am not on commission for the WOW 
Book. 

Graham Blackwell ARPS 
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Clive would like to hear from any 
members who would like to join the 
Digital Portfolio circle. The portfolio 
disk is circulated with each contribu-

tor removing their previous image 
and adding another before sending 
the disk on. Or, it may be that you 
would prefer to share your images 

using prints, especially as some 
members are concerned about the 

possibility of importing a virus. 
Please let Clive know if you would be 
interested in contributing to either a 

disk or print portfolio. 

Clive Davies LRPS 
Folio Secretary 

39 Wigan Terrace 
Bryncethin 
Bridgend 

Mid Glamorgan 
CF32 9YE 

Windows 

The original image was 
taken on Fuji Slide Film at 
Lake Garda. I have done 
little work on 
this picture except 
correcting the verticals, 
removing some road signs 
from the bottom right of 
the image and then 
applying a cutout filter. 

David Burgess LRPS 



The Yellow Boat 

Issue 6 

Do you have a suggestion for a 
regional or national digital 

imaging event? 

Could you host a meeting? 

Do you have ideas that could 
enable members to share their 

experiences, display their prints 
and build upon their 

enthusiasms? 

Pan of a slide taken in Fraserburgh harbour and fairly heavily cropped. To emphasise 
the harbour wall I superimposed a "find edges" layer and posterised and then superim
posed another layer of just the boat in almost original form to preserve the flowing lines. 

The secretary and regional 
organiser would be delighted to 

hear from you. 

See the back page for contact 
details. 

Tom Ashcroft, 

When I put this panorama wgether I had 
intended t0 do it seamlessly, but as the 
shots were taken on a snap camera, hand 
held at sunset and I only had a week to do 
it for a Christmas present I realised it was 
an immense task. I emphasised the 
higgledy piggledy outline and liked the 
effect. 

Pauline Johnson 

Golden Bal l. 

This is one of my Bryce 2 images that I enjoy doing. I find this type of 
work more challenging because , unlike Phot0shop where one 
manipulates an existing image, wich Bryce all you start with is a blank 
screen, and an imagination. It also helps if, like Dali, you are a bit round 
the twist as well. I have created abouc 300 of these images of which 150 
have bitten the dust and disappeared into the ether. Hope you like it. I 
should mention that this is imagery, not phot0graphy. :Jo photographic 
content. 

Pram 
The original image of the pram pusher is a monochrome. The streaky 
background, believe it or not, is a medium format colour trannie of the 
tulip fields of Kukkenhof, Holland turned through 90 degrees. The 
barrier was computer drawn and then the finished image was treated 
with a Photoshop Filter, accented edges. 

Jack Casement ARPS 
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An LRPS Digital Panel 

At the March 1998 RPS Northwest Event at Lancaster I had an panel of digitally produced 
prints accepted for a LRPS. I had been working on two panels for submission, one of 12 x 
16 colour prints from my ttip to Nepal, the quality was good but I was never entirely happy 
with it as I felt it contained too many people pictures. The other panel was a series of 
digital inkjet prints, that originated from my own photographs mainly slides, that I saw as 
having potential if digitally manipulated and printed. In the panel I tried to show a range of 
subject matter, and styles of phorography as well as demonstrating an understanding of the 
use of different levels or amounts of manipulation t0 achieve a final image. 

Lonesome Tree 
This was a monochrome negative taken near Malam that I scanned into the computer, 
it has been laterally reversed. Contrast and brightness levels have been manipulated 
similar to normal burning in etc., but often on smaller areas of the picture. 

Brother and Sister 
This started as a slide taken in Kathmandu which was spoilt by a row of bright highlights 
along the top of the frame. The slide was transferred to CD, and the highlights masked our. 
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Venician Canal 
This started as a colour slide transferred to 
CD. The sky area and the buildings at the far 
end of the canal had their colour saturation 
and contrast increased, the canal in the 
foreground was lightened and a the brick/ 
swne work enhanced by the use of 'find 
edges' 

The Placca 
This was a colour slide of Dubrovnik, which 
I had accepted in couple of Exhibitions and 
then transferred t0 CD. The result has been 
achieved by a combination of 'finding edges' 
and posterisation. 



Girl and Taj 
The girl was part of colour print taken in Jodphur and the Taj was a slide transferred to 
CO. The Taj was converted co monochrome and the contrast on the building increased, 
and the foreground lightened The girl was 'cut out' and reversed (as the lighting was 
crossed and I needed her on the right hand side of the picture) before combining the 
images 

Memories 
This started as 2 6 x 4 colour prints on of a girl in the Good Friday procession in Benidorm 
and the other of the now destroyed bridge at Mostar. The girl was 'cut out' and placed 
onto the picture of Mostar, some adjustment was made to the shadow detail on the right
hand bridge buttress. 

My digital imaging started in December 1996 but I have been involved with computers 
since the days of the Sinclair ZX8, BBC Bs, Masters, Archimedes, PCWs and PCs. I do not 
possess a copy of Photoshop but have done all my manipulation using Phot0 Deluxe 
version 1 My prints were produced with an Epson Phoco Stylus printer and Jessops A4 
matt inkjet paper. 

Jon Allanson LRPS 

Issue 6 

The Hut 

The Express 

HvarTown 

Bring on the Clown 

Submissions of images and text for 
DIGIT are very welcome. Please 

submit them on disk or by email if 
possible, although both can be 

scanned in if necessary. 

13 



DIGIT 

Tips on Photoshop 4 for Photographers 

This article is intended for those acquainted with Photoshop 4 and 
using Windows; it is not for novices. For beginners I would like to 
suggest two books. The first one is the Visual Quickstart Guide, 
Photoshop 4 for Windows by Elaine Weinman and Peter Lourekas, 
Published by Peachpit Press ISBN 0/201/68842/5. In my opinion it is 
the best book for beginners. The second book, which is more 
detailed and good for reference, is Photoshop 4 for Windows 95 
Bible by Deke McClel land IDG Books World Wide Incorporated 
ISBN 0-7645-4032-7 

This article, as the title suggests, contains hints and tips on what I 
found to be useful and important in digital manipulation of 
photographs. It is not a fully researched and authoritative guide for 
Photographers, and neither is it comprehensive. It is based largely 
on my opinion of what I considered to be important and useful in 
my process of learning Photoshop 4.1 am sure others would have 
different views and opinions on what is dealt with here. They might 
consider other things more important, and have better ways of 
dealing with the same aspects of Photoshop 4 that I have dealt with, 
and I would welcome their contributions. 

Before you start 

I. From the outset decide to use shortcuts (using keyboard instead 
of the mouse). It is not only easier and quicker but it saves a lot of 
strain on the hand operating the mouse. I shall, throughout the 
article, give the most useful shortcuts. 

2. It is best not to have more than one or two palettes on the 
monitor screen at any time, this avoids clutter and makes as much 
space as possible for the image which is worked upon. This is 
particularly so if you have a small screen. How you personalize your 
palettes depends on the way you work. I use two palettes, one for 
Layers, Channels and Info, and the other for Brushes, Navigator and 
Options. To have the former palette on and off the screen press F7 
and for the latter F5. If you use two palettes regularly you can create 
a third palette of Colour, Swatches and Paths, and use F6 for it to be 
on and off the screen. If your screen is less than 17" and you want 
to manage with only one palette, compile one for Layers, Brushes 
and Options and that can be switched on and off by pressing either 
F7 orF5. 

3. To set the Preferences you can refer to the two books recom
mended. It might be best to leave most things to the default 
settings except for three of them. GO into File> Preferences > 
General > and then click Next twice to bring the Display and 
Cursors Dialog Box up in Preferences. Set Brush Size in Painting 
and Cursors and Precise in Other Cursors. \Xlhen the Brush Size is 
selected, you will see the actual size of the brushes up to 300 pixels 
if you are using any paint or editing tools. If the brush size is larger 
than 300 pixels the Standard Cursor will appear on the screen. I 
cannot imagine how one can use brushes prol?erly without this 
facility. 
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Then click Next five times to bring up the Memory and Image Cache 
Dialog Box and set 100% in Physical Memory Usage. 

Background versus layers 

The difference between a Layer and a Background is that the former 
has a transparent base and the latter a white base. We photogra
phers using negatives or slides are more familiar with the transpar
ent base. There are considerable limitations in editing a Background 
compared to a Layer. 

The most glaring ones are the inability to use a layer mask, to 
change the position of the background in a multilayer document, to 
apply a blending mode or to change the opacity. In many circum
stances it is best to convert a background into a layer. To do this 
double click the "Background" in the Layers Palette and a Dialog 
Box will appear. You could either keep the name "Layer Zero" as it 
appears or give a name of your choice. Leave the opacity to 100% 
and Mode to Normal and click OK and the Background will become 
a layer. It is now possible to use all the editing procedures available 
for layers which are not for the backgrounds. 

Rarely is it necessary to change a layer back into a Background. To 
do that activate the layer you want to make into Background on the 
Layers Palette, Alt click New Layers button in the Layers Palette and 
a New Layers dialog box appears. Keep opacity to 100% and in the 
mode drop down list choose Background, Click OK and a white 
background will appear at the bottom of the Layers Palette. Make 
visible only the Layer you want to make into a Background and the 
new white Background which you have just created, and then from 
the drop down list choose Merge Visible and the layer will be made 
into a background. 

Selections 

To select an entire layer use Ctr! + A, to deselect Ctr! + D, to 
inverse a selection Ctr!+ Shift+ I Oetter I not 1), and to hide or 
show a selection Ctr! + H. 

To select an image (pixels only) on a transparent layer Ctr! click the 
layers name on the Layers Palette. 

When using a Rectangular or Eliptical Marquee Tool to drag from 
the centre, hold down Alt and drag. You must release the mouse 
first before the Alt key. 

Hold down Shift key while dragging to create a circle or a square, 
and to draw them from the centre hold down Shift and Alt and 
again release the mouse before Shift and Alt. When using the 
Polygon Lasso tool, anchor points are created each time you click. If 
mistakes are made in the positioning of the anchor point, any 
number of anchor points can be undone by repeatedly pressing 
delete. This is most useful and surprisingly it is not given in the 
Manual or any other book. At times open ends prematurely join 



accidentally (usually by inadvertently double clicking). If that 
happens, save as a New Channel whatever has been selected up to 
that stage by using the Save Selection command in the Selection 
Menu. Deselect what has been saved. Continue to make a second 
selection of the remaining area which was missed, then from the 
Select Menu choose Load Selection. In the Channel will appear #4 
indicating the previously saved selection. Click Add to Selection 
button and click OK. The two selections will become one which was 
the initial intention. It may prove necessal)' to refine the selection 
by either adding or subtracting from it as given below. 

To add to a selection or make an additional selection, Shift Drag any 
selection tool other than the Polygon Lasso or the Magic Wand. 
With the Polygon Lasso instead of dragging, it is necessary to click 
to mark out an area to be added to the selection, and for the Magic 
Wand click on the unselected area. To subtract from a selection 
press Alt instead of Shift, and in the case of the Magic Wand click 
the selected areas you wish to subtract. When working with the 
Lasso Tool if you press Alt this stops a Lasso selection from closing 
if the Mouse is released, it also changes the Lasso to a Polygon Lasso 
tool until Alt is released. 

If you have Feathered a selection and you don't like the look of the 
feathered area there is nothing you can do but select again. 
However, if you make the selection with no Feather and when 
finished go into Select> Feather and then choose the radius you 
want, you can change the Feather to your hearts content by going 
backwards and forwards into Edit> Undo. 

The Colour Range is best used when a uniform area of colour or 
tone has to be selected, and once the selection is done it could be 
made Greyscale (Mono chrome) by desaturation or the colour can 
be changed by using Hue and Saturation Command. This is 
particularly useful in studio portrait or similar images where the 
background is a uniform colour or tone. 

When using Magic Wand you find numerous islands of selections. 
They can be joined by Shift clicking the unselected areas between 
them which can be quite tedious. 

An alternative is to go to Select> Modif-> Expand and enter in the 
Dialog Box which appears, a number for the pixels (as to what 
number to enter you will learn from experience) and click OK. Then 
repeat the process but on this occasion choose Select> Modify> 
Contract instead of Expand and enter the same number of pixels 
that you entered when you expanded. This either eliminates or 
reduces the islands of selection. The only way to learn to use this 
method is by experimentation and at the end you might need to 
modify the selection in other ways. 

Refining selections 

This section refers only to selections made co cut out an image to 
put on a layer, and not to selections made in an image for the 
purpose of editing that area or applying a ftlter to it. 
Most workers, after making a selection by any of the selection 
methods, would refine it by using Quick Mask. As the area masked 
with this method is covered with 50% red colour, it proves in the 
case of some images, very difficult to see clearly to refine the image. 
I think a much better way of doing it is by using a Layer Mask. 
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To cut out a part of our image to put on a layer, roughly select that 
area by any method of selection you choose. If selecting the 
background proves easier, by all means do that and then invert the 
selection. Copy the selection and paste it on a New transparent 
document. As now the image is not on a Background you can apply 
a Layer Mask by choosing Layer> Add Layer Mask> Reveal All (Hide 
All is rarely useful). You will see on the Layers Palette co the right of 
the Eye a small circle which means that the Layer Mask is active. If 
you click on the thumbnail of the image on the layer in the Layers 
Palette a small brush will appear indicating that the image on that 
layer is active. When you want to work on the Layer Mask or the 
image on the layer, first make sure that the one you want to work 
on is activated. This is important as otherwise by mistake you will 
paint the image instead of the Layer Mask. 

By painting the Layer Mask with Black (the default foreground 
Colour) you make the layer transparent (mask it), but if you want to 
restore part of the image you mistakenly masked (made transpar
ent) you paint it with white (default background Colour). If you 
want an area only partially transparent (masked) paint it with gray 
by reducing the opacity of black by the appropriate amount in the 
Paint Brush Palette. You can toggle between black and white while 
painting by pressing the letter X key. Masking partially (by painting 
with gray) is not possible by the Quick Mask method. 

Once the cut out image on the layer is just as you want it, it is best 
to Apply the Layer Mask. To do that choose Layer Menu, then> 
(paradoxically) Remove Layer Mask, a dialog box appears which 
gives the option of Apply, Remove or Cancel, click Apply. You can 
apply Layer Mask as often as you wish and create a new Layer Mask 
to continue the task. I apply Layer Mask from time to time just as I 
would Save at various stages when working on an image. Layer 
Mask can be used co make what I call Gradient Selections. 

Scanning the quality of the output 

This and the following section are difficult to explain and would be 
much easier co demonstrate with the computer. Serious phocogra
phers want the digital output (prints) to be comparable in quality to 
those produced photographically. Affordable digital cameras as of 
now cannot give as good a quality image as by scanning a negative 
or a slide. Therefore, the best method at present for inputting 
(bringing the photographic image into the computer) is by 
scanning the negative or the slide. 

To get photographic quality output, it is essential to take into 
consideration at the scanning stage the size and resolution at which 
you will print. 

These notes have been extracted from a booklet written by 
Dr Eddy Sethna FRPS 

(Vice Chainnan of the Digital Imaging Group). 

If you would like a copy of the complete document please 
contact him at the address given on the back page. 
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lbe Digital Imaging Group coosists of members of the Royal Photographic Society who have elected to pay an extra subscription to 
~ the group's joumal DIGIT and to work together via meetings and a drculated portfolio to promote digital imaging. 
Submissions for Inclusion in DIGIT are very welcome. Please note that the editor will assume that all persons submitting material 
have ensured that they own the full c:opyrigbt of all the images and tq;t submitted, and that any legal in&ingements will be the 
responsibility of the submitter. Copyright of all the material published is reserved in all countries on behalf of the RPS and the 
authors. Any views exprascd are not necessarily those of the Royal Photographic Society nor of the Digital Imaging Group. 

Internet: http://wwW.wycliffe.eo.uk/rps-digroup 

lbe committee: 

Chairman: Mr Barrie Thomas FBIPP FRPS 
Vice Chairman: Dr Eddy Sethna FRPS 
Treasurer: Mr Geoffrey Carver LRPS 
Secretary: Mrs Glenys Taylor ARPS 
Editor DIGIT: Mr Bill Henley LRPS 
Regional coordinator: Mr Cliff Davies LRPS 
Folio secretary: Mr Clive Davies LRPS 

Mrs Margaret Collis ARPS Digital Imaging Group 
Mr John Long ARPS 
Mr Colin Myers 

Digital Imaging Group 'Members' Day 

on Sunday 28th June 1998 at 10am 

at the Ocatagon, Milsom Street, BATH 

with Barrie Thomas FRPS FBIPP 

and Adrian Davies ARPS 

Your chance to see and hear two of the leading exponents 
of Digital Imaging plus a chance co see the Digital Imaging Exhibition. 

TicketS are available from: 

Glenys Taylor ARPS, 10 Shoreditch Road, Taunton, Somerset, TAI 3BU 
Please enclose a scamped addressed envelope for the return of the tickets. 

Tickets £4.00 for DI group members and £5.50 for non-members. 

Visit the Digital Group's Members exhibition 
at the Octagon from 24th June to 7th July 1998. 

The AGM for 1999 is to be held in the Sunley Theatre at the RPS Headquar
ters in Bath on Saturday 3rd April 1999 at 10am. Members may bring prints 
for the members exhibition. Those who bring prints will be asked if they 
would like to take part in the selectiqn, names to be drawn from a hat. At 

least one print per person will be selected. There will be a number of 
speakers to give mini-presentations. 
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Contact details: 

Barrie Thomas FBIPP FRPS 
85 Beech Gardens 
Rainford 
WA118EB 

01744 883541 

barrie@fotografx.demon.co.uk 

Glenys Taylor ARPS 
10 Shoreditch Road 
Taunton 
Somerset 
TA13BU 

01823 323986 (tel & fax) 
01823 282516 

106503,647@compuserve.com 

Bill Henley LRPS 
Old Manse 
Middleyard 
King's Stanley 
Stonehouse 
Gloucestershire 
GL103QD 

01453 825068 

weh@wycliffe.co.uk 

Cliff Davies LRPS 
Roughwood 
Roughwood Hollow Hassell 
Sandbach 
Cheshire 
CW114XX 

01270 883199 

cliffdavies@email.msn.com 

Bill Henley I.RPS 
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